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Abstract

During neuronal development, axons navigate the cortical environment to reach their

final destinations and establish synaptic connections. Growth cones -the sensory

structures located at the distal tips of developing axons- execute this process. Studying

the structure and dynamics of the growth cone is crucial to understanding axonal

development and the interactions with the surrounding central nervous system (CNS)

that enable it to form neural circuits. This is essential when devising methods to

reintegrate axons into neural circuits following injury in fundamental research and pre-

clinical contexts. Thus far, the general understanding of growth cone dynamics is

primarily founded on studies of neurons cultured in two dimensions (2D). Although

undoubtedly fundamental to the current knowledge of growth cone structural dynamics

and response to stimuli, 2D studies misrepresent the physiological three-dimensional

(3D) environment encountered by neuronal growth cones in intact CNS tissue. More

recently, collagen gels were employed to overcome some of these limitations, enabling

the investigation of neuronal development in 3D. However, both synthetic 2D and 3D

environments lack signaling cues within CNS tissue, which direct the extension and

pathfinding of developing axons. This protocol provides a method for studying axons

and growth cones using organotypic brain slices, where developing axons encounter

physiologically relevant physical and chemical cues. By combining fine-tuned in utero

and ex utero electroporation to sparsely deliver fluorescent reporters along with

super-resolution microscopy, this protocol presents a methodological pipeline for the

visualization of axon and growth cone dynamics in situ. Furthermore, a detailed toolkit

description of the analysis of long-term and live-cell imaging data is included.
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Neurons are highly polarized cells that represent the basic

computational unit in the nervous system. They receive and

emit information that relies upon compartmentalization of

input and output sites: dendrites and axons, respectively1 .

During development, axons extend while navigating an

incredible complex environment to reach their destination.

Axon navigation is guided by the growth cone, a sensory

structure located at the tip of the developing axon. The growth

cone is responsible for detecting environmental cues and

translating them into the dynamical spatial reorganization

of its cytoskeleton2,3 . The resulting morpho-mechanical

reactions instruct the growth cone to extend or retract from

the triggering cue, leading to specific axon maneuvers.

The current understanding of axon extension and growth

cone dynamics stems from studies evaluating axon growth

over two-dimensional (2D) substrates2,4 ,5 ,6 ,7 . These

pioneering studies identified sophisticated interplay between

growth cones and growth substrates and revealed striking

differences dependent on substrate characteristics such

as adhesiveness and stiffness8,9 . Led by these insights,

extracellular environmental cues were hypothesized to dictate

axon growth, with the growth cone cytoskeleton executing

this growth2,10 ,11 ,12 . Notably, neurons can extend axons in

non-adhesive substrates (e.g., poly-lysine, poly-ornithine)13 .

Moreover, substrate rigidity can influence axon growth rate

independent of cell adhesive complexes8 . Hence, studying

growth cone dynamics in 2D substrates alone cannot

accurately model the balance of forces that arise from

the interaction of axonal growth cones with physiologically

relevant three-dimensional (3D) environments, such as those

found in vivo.

To overcome the limitations of the 2D assays, axon growth

and growth cone dynamics have been studied in 3D

matrices8,9 . These matrices pose more physiological context

yet allow studying cell-intrinsic mechanisms of axon growth.

It enables growth cone examination in a single-cell fashion in

a variety of conditions and pharmacological treatments9 . In

such 3D environments, axons displayed distinct cytoskeletal

dynamics and grew faster than those observed in 2D cultured

neurons9 . These elegant studies demonstrated the influence

of an extra dimension on the reorganization of the growth

cone cytoskeleton and, consequently, on its behavior.

Despite apparent advantages presented by 3D matrices over

2D surfaces in supporting native-like neuronal development

and axon growth, they remain a simplified synthetic scaffold

that cannot reflect the complexity of dynamics observed

in central nervous system (CNS) tissue. Here, delivery of

reporter plasmids by ex utero and in utero electroporation was

combined with brain organotypic slice culture and in situ live

super-resolution imaging to analyze growth cone dynamics

within a physiological context. This methodology allows

visualization of developing axons while experiencing the 3-

dimensionality of in vivo environments and the complexity

of its physicochemical composition. Lastly, user-friendly

procedures to measure axon growth and growth cone

dynamics using commonly licensed and publicly available

software are described.

Protocol

Animal experiments must comply with the relevant

institutional and federal regulations. Embryonic day 15.5 and

12.5 (E15.5 and E12.5) pregnant female C57BL/6JRj mice

were used in this protocol. Experiments were performed in

accordance with the Animal Welfare Act of North Rhein-

Westphalia State Environmental Agency (Landesamt für

Natur, Umwelt und Verbraucherschutz (LANUV)).

https://www.jove.com
https://www.jove.com/


Copyright © 2021  JoVE Creative Commons Attribution-NonCommercial-NoDerivs 3.0 Unported
License

jove.com October 2021 • 176 •  e63068 • Page 3 of 24

1. Preparation of plasmids for injection

1. Isolate DNA using endotoxin-free Maxiprep kit according

to manufacturer's protocol (see Table of Materials).

2. Mix selected DNA at the desired concentration (Table 1)

and 10% Fast Green solution (see Table of Materials) to

visualize the delivery of DNA mixture into brain ventricles.
 

NOTE: Specific plasmids were used for sparse labeling

of the cortical neurons (Figure 1A), filamentous actin

(F-actin) structures in the growth cone (Figure 1B),

and dual-labeling of the growth cones within the same

cortex (Figure 1C). All plasmids (Table 1) used in this

protocol have been deposited in Addgene (see Table of

Materials).

3. Prepare glass capillaries using a capillary electrode

puller set as per the following program: pressure: 500,

heat: 800, pull: 30, and velocity: 40.

4. Load 15 µL of DNA/Fast Green mix into each glass

capillary using micro loader pipette tips.
 

NOTE: Ensure that no bubbles form.

5. Store DNA-filled capillaries in a 10 cm dish with a piece of

modeling clay across the diameter of the dish. Capillaries

can be loaded and stored at 4 °C the day before the

experiment. Seal the back end of the capillary with

flexible film to prevent drying.

2. Preparation of solutions

1. Prepare Hank's Buffered Salt Solution-supplemented

with glucose (HBSS-G).

1. Add 0.5% of 20% glucose stock to a bottle of 1x

HBSS. Mix well and store at 4 °C for up to 2 weeks.

For the embryo extraction, bubble HBSS-G solution

with carbogen (95% O2 and 5% CO2) using bubbling

stone shortly before embryo collection.

2. Slice media solution

1. Prepare fresh slice media containing Neurobasal

1x, 5% horse serum, 5% foetal calf serum, B27

supplement 1:50, L-glutamin supplement 1:400,

penicillin-streptomycin 1:200, and Neuropan-2

supplement 1:100 (at pH = 7.3), under sterile

conditions (see Table of Materials).

2. Prepare 3 cm dishes with 1 mL of slice media each.

Place in the incubator at 35 °C with 5% CO2 for at

least 1 h before the experiment to equilibrate the

media's pH through gas exchange.
 

NOTE: Media pH equilibration is caused by

acidification of the media by the CO2 from the

incubator. Slice media can be stored at 4 °C for up

to 1 week.

3. Low melting point agarose solution (3%)

1. Weigh the desired amount of low melting point

agarose powder and dissolve in an appropriate

volume of 1x HBSS-G in a glass bottle.

Approximately 7 mL of agarose solution per brain is

needed.

2. Place the bottle in a microwave for 2-3 min, with the

cap loosely placed, and shake every 10-20 s.

3. Once the powder has completely dissolved, place

the bottle in a water bath or bead bath set to 37 °C

at least 1 h before the experiment to allow agarose

to cool down.
 

NOTE: It is recommended to heat the agarose

twice over 15 min to ensure the agarose powder is

dissolved. This is crucial for the proper adhesion of

https://www.jove.com
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agarose to brain tissue. A thermometer should be

used to measure the temperature of the agarose

solution while embedding brains, making sure it

is between 37-40 °C. Brains from different aged

animals have different rigidity. It is recommended

to test a range of agarose concentrations to find

homogeny between tissue and agarose.

4. Prepare Phosphate Buffered Saline with 0.3% Triton

X-100 (PBS-T).

5. Prepare Phosphate Buffered Saline with 0.2%

Sodium Azide (PBS-NaN3).
 

NOTE:  Solutions described in steps 2.4-2.5 are for

use in the later immunohistochemistry step.

3. Preparation of the surgery station

1. Clean the surgery station with 70%-96% ethanol and

place operation underlay on the station surface.

2. Sterilize the surgery instruments by rinsing with

70%-96% ethanol, followed by dry sterilization in a hot

bead sterilizer.

3. Clean platinum tweezer electrodes (see Table of

Materials) with 70%-96% ethanol before connecting to

the pulse generator.

4. Insert a DNA/Fast Green-filled glass capillary into the

capillary holder. Immediately before use, gently break

off the capillary tip using fine scissors and test solution

flow inside a 1.5 mL microcentrifuge tube filled with pre-

warmed saline or water.
 

NOTE:  Figure 2A,B show surgery station set-up and

tools used for ex utero electroporation (EUE) and in utero

electroporation (IUE).

5. For IUE, warm-up saline solution to 37 °C in a water bath.

4. Embryo extraction

1. Place pregnant mouse in anesthesia inducer chamber

with 5% isoflurane until the mouse is deeply

anesthetized. Confirm anesthesia by the absence of

pedal withdrawal reflex.

2. Transfer the mouse to an operation underlay and

maintain isoflurane at 1.5%-2% through a nose cone.

3. Apply ointment to both eyes to prevent corneal drying.

4. Shave the mouse's abdomen, and then use 70%-96%

ethanol-soaked gauze to remove shaved hair. Clean the

area with betadine.

5. Using sterile small surgical scissors, make a 2 cm skin

incision along the abdominal midline, followed by a 1.5

cm muscle incision.
 

NOTE: Incision size depends on the embryo size.

Indeed, larger embryos will require a larger incision to

accommodate their extraction.

6. Cut a hole in the middle of the gauze sufficiently wide to

fit the skin incision (~2 cm in diameter), soak it with warm

saline, and place it around the abdominal opening.

7. Pull out both uterine horns using a cotton bud soaked

in warm saline or using forceps, carefully grabbing

the spaces between embryos to pull them out. Place

embryos on wet gauze (Figure 2C).
 

NOTE: Even a small damage to blood vessels and

capillaries around the uterine horns will likely result in

profuse bleeding. Therefore, avoid direct handling of

these vascularised areas at all times.

8. Cut open the uterine sack and remove each embryo

(Figure 2D).

https://www.jove.com
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9. Euthanize each embryo immediately after extraction via a

descending diagonal cut, ensuring complete spinal cord

transection (Figure 2E).

10. Place the embryos in a 10 cm dish containing HBSS-G

on ice.
 

NOTE: Beheading the embryo is avoided to prevent

DNA/Fast Green mixture leakage from the brain and

facilitate easy embryo positioning in the holder (see ex

utero electroporation, step 5).

11. Sacrifice the mother immediately after extraction of

embryos by performing cervical dislocation.
 

NOTE: Here, the mother is euthanized under anesthesia

to spare it from any further post-procedure pain or

suffering in compliance with the protocol approved by

the Animal Welfare Act of North Rhein-Westphalia State

Environmental Agency (LANUV).

5. Ex utero electroporation (EUE)

1. Pick up an embryo and place it in the holder.
 

NOTE: A cut 1 mL pipette tip attached to the end

of a cell scraper is used as an embryo holder. It is

essential to keep arms of embryos outside the tip during

the procedure to prevent them from sliding into the tip

(Figure 2F-I). The diameter of the pipette tip is easily

adjustable to accommodate embryos of various sizes.

Cut a second tip at length where the diameter of the tip

matches embryo size and use it as an adapter insert to

the holder mentioned above.

2. Carefully insert DNA/Fast Green-filled glass capillary

through the embryo's skull into the lateral ventricle and

inject 2-3 µL of DNA plasmid mix (Figure 1A,B; Table 1)

into each ventricle (Figure 2F).
 

NOTE: Use the lambdoidal and sagittal sutures as a

guide for the location of DNA injection. The lambdoidal

and sagittal sutures are fibrous joints connecting the

bone plate of the skull. The former joins the parietal bone

with the occipital bone, and the latterjoins the two parietal

bones.

3. Hold the embryo's head between platinum tweezer

electrodes at the appropriate angle to target the desired

brain area (60° angle in this case), with the cathode

facing the area where DNA transfer is intended (Figure

2G-H).

4. Apply five pulses at 30 mV with an interval of 1 s and a

duration of 50 ms using a square wave pulse generator.
 

NOTE: Bear in mind that brains in EUE experience

a more effective electric field than those in IUE.

Hence, at a given DNA concentration, EUE results in

higher efficiency of DNA transfer than IUE, and DNA

concentrations need to be adjusted accordingly.

5. If bilateral electroporation is desired, repeat steps 5.3-5.4

with the cathode and anode mirroring the previous

position to target the contralateral cortex.
 

NOTE: Since both ventricles were injected with DNA,

cortices of both hemispheres were targeted.

6. Place the electroporated embryo in a 6 cm dish

containing ice-cold HBSS-G. Repeat steps 5.1-5.6 for all

embryos required.

6. In utero  electroporation (IUE)

1. Inject pregnant mouse with analgesic; 50 µL of

buprenorphine (0.1 mg/kg) (see Table of Materials)

subcutaneously, 20 min before the procedure.

2. Perform steps 4.1-4.8 from the embryo extraction

section.
 

https://www.jove.com
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NOTE: Avoid leaving embryos exposed unnecessarily by

covering them with sterile gauze soaked in warm saline.

3. Using fingertips, gently rotate the embryo inside the

uterus until lambdoidal and sagittal sutures are located

(Figure 2J). Carefully insert DNA/Fast Green glass

capillary through the uterine wall and embryo's skull into

the lateral ventricle and inject 2-3 µL of DNA plasmid

mix (Figure 1A,C) into either one or both ventricles as

desired (Figure 2K-L).
 

NOTE: Excessive finger pressure on uterine horns could

lead to amniotic sack collapse.

4. Hold the embryo's head between platinum tweezer

electrodes at the appropriate angle to target the desired

brain area (60° angle in this case), with the cathode

facing the area where the DNA transfer is intended. Avoid

squeezing the uterus since it may cause the collapse of

the amniotic sack (Figure 2M).

5. Apply five pulses at 35 mV with an interval of 600 ms and

a duration of 50 ms using a square wave pulse generator.

6. If both lateral ventricles were injected, repeat steps

6.5-6.6 with the cathode and anode mirroring the

previous position to target the contralateral cortex.

7. Repeat steps 6.3-6.6 for all embryos required.

8. Once all the required embryos have been electroporated,

use a saline-soaked cotton bud to place uterine horns

back inside the abdominal cavity gently.
 

NOTE: The addition of saline solution into the peritoneal

cavity will help uterine horns slide back into position.

9. Suture muscle and skin incisions using 5-0 suture

material. Use suture clips to secure the wound and

disinfect the suture wound by spraying it with betadine

(Figure 2N-P).

10. Inject the mouse with 200 µL of 5% glucose

subcutaneously.

11. Inject the mouse with an antibiotic; 50 µL of Enrofloxacin

(5 mg/kg) subcutaneously (see Table of Materials).

12. Place the mouse back in the recovery cage and maintain

warmth using a far-infrared warming light or heating pad

for at least 20 min post-procedure (Figure 2Q).

13. Monitor the mouse daily, and inject meloxicam after the

procedure for pain relief following institutional and federal

guidelines.

14. Extract embryos 2 days after the procedure (i.e., E17.5)

following step 4.

7. Brain extraction and embedding in agarose

NOTE: It is recommended to carry out the following steps

under a dissection microscope for better precision. Avoiding

damage to the brain is critical for the success of the

procedure.

1. Set up extraction tools in a sterile working space under a

dissection hood (Figure 3A).

2. Separate the head of an embryo from the rest of the body

using dissection scissors.

3. Fix the head as shown in Figure 3C, and then remove

the skin and skull by cutting along the midline, starting

from the base of the head toward the nose (Figure 3D).

4. Peel the skin and skull laterally, making a big enough gap

(~1 cm) for the brain to be excised.

5. To remove the brain, insert the closed tip of sterile

dissection scissors, starting from under the olfactory bulb

moving toward the brain stem (Figure 3E).

https://www.jove.com
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6. Cut off the brain stem and trim any loose pieces of

meninges around the brain (Figure 3F).
 

NOTE: Loose meninges often cause slices to remain

attached to the agarose block after cutting, leading

to detaching of tissue from the agarose during slice

collection.

7. Repeat steps 7.1-7.6 for all embryos and keep the brains

on ice (ideally no longer than 30 min) until the embedding

step.
 

NOTE: The following steps 7.7.1-7.7.4 refer to brain

extraction of E12.5 brains.

1. Isolate the top of the head just below the eye, as

shown in Figure 3G.

2. Cut the skin and skull on top of the brainstem,

following the dashed line as shown in Figure 3H,

without removing the brainstem.

3. Make a 2 mm skin-skull incision at the back of

the head, as shown in Figure 3I (see drawings for

clarity).
 

NOTE: This incision provides initial gripping points

to peel off the layers of skin and skull. Typically, they

come off as one layer. The typical incision size is 2

mm, corresponding to the length of the cutting edge

of the used micro spring scissors.

4. Start peeling off skin-skull layers by securing one

side of the incision and pulling the other carefully.

With the same care, finalize by peeling off the base

of the head until freeing the brain (Figure 3J).
 

NOTE: This must be done with great care, observing

that the brain is not being pulled along the tissue

layers. Alternate sides to remove the tissue covering

the brain.

8. Pour warm agarose (at 37-40 °C) in a 3 cm dish.

9. Pick up the brain using a perforated spoon and remove

excess liquid by dabbing the bottom of the spoon against

dry tissue paper. Place the brain in an agarose dish.
 

NOTE: It is essential to remove as much liquid from

around the brain as possible to allow for better adhesion

of agarose to the tissue.

10. Put the dish with liquid agarose on ice. Using a smaller

spoon, mix agarose for 10 s for even cooling. Maneuver

the brain to the middle of the dish. Place the brain

horizontally in the dish with the dorsal side up, ensuring

it is completely covered with agarose from all directions

(Figure 3K).
 

NOTE: Brains will often sink to the bottom of the dish

once placed in agarose; lift the brain using a small spoon

until a gap of 1-2 mm under the brain is established.

11. Repeat steps 7.8-7.10 for all brains.

12. Once agarose has polymerized, add 500 µL of HBSS-

G on top of the agarose block to prevent drying. Then,

cover the dish with ice.
 

NOTE: Keep the sample on ice for 5 min before

sectioning to allow the brain temperature to reach 4 °C.

8. Organotypic slice culture

NOTE: Clean vibratome and surrounding surfaces with

70%-96% ethanol to avoid slice contamination. The set-up of

the vibratome workstation (see Table of Materials) is shown

in Figure 3B.

1. Fill the vibratome buffer tray with cold HBSS-G and

the outer tray with ice to maintain the HBSS-G cold

throughout the procedure.

2. Continuously supply HBSS-G in the buffer tray with

carbogen using a bubbling stone.

https://www.jove.com
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3. Using a fresh blade, make a large cut (~2 x 2 cm) around

the brain and remove a block of agarose containing

the brain, with enough surrounding agarose to trim the

agarose into a small rectangle block.
 

NOTE: This step allows adjusting the block's angle so

that the sagittal axis of the brain is perpendicular to the

vibratome plate and the coronal axis aligns parallel to the

blade. Leave around 5 mm of agarose at the dorsal side

of the brain for easy handling of the slices.

4. Place a small drop of fast-adhesive solvent-free

superglue in the middle of the specimen holder and

spread to an area that will cover the bottom of the

agarose block.

5. Gently pick up the agarose block and dry the bottom

by dabbing against tissue paper. Place the block on the

glued area of the specimen holder, with the rostral side

of the brain up. Put the specimen holder on ice and allow

the glue to dry for 1 min.

6. Once the glue has dried, place the specimen holder in

the buffer tray.

7. Cut the brain in coronal slices at an angle of 15°.
 

NOTE: The thickness of the slices can vary depending on

the application. Here, brains were sliced at a thickness

of 150 µm. Set vibratome speed to 1.0-1.5 mm/s for

trimming excess agarose on top and trimming olfactory

bulbs. Reduce cutting speed to 0.5 mm/s for collecting

cortical slices for analysis. Most vibratomes can be

paused to collect each slice. If reduced quality of slices

or detaching of tissue from agarose are experienced,

reducing the cutting speed or replacing the vibratome

blade can help.

8. Using clean spatulas, collect brain slices and place

them on Polytetrafluoroethylene (PTFE) membrane,

immobilized in a 35 mm glass-bottomed dish using

paraffin (up to five brain slices/ membrane) (Figure 3L-

M).
 

NOTE: Fix the PTFE membrane inside a 35 mm

glass-bottomed dish using wax. This will stabilize the

membrane when adding the slice culture media and also

during imaging.

9. Using a 200 µL pipette, remove excess HBSS-G from

around the slices on the PTFE membrane, leaving the

slices semi-dry.

10. Add 500 µL of slice media (pre-warmed to 35 °C) directly

to the space under the PTFE membrane.
 

NOTE: No bubbles must form under the membrane when

adding the media. This will leave whole or partial slices

with no media exchange. Replace 200 µL of media every

2 days in culture or after every imaging session.

11. Incubate the slices at 35 °C with 5% CO2.

9. Immunohistochemistry

1. Fix slices with 1 mL of 4% paraformaldehyde (PFA)-

supplemented with 4% sucrose-per dish. Incubate at RT

for 30 min.
 

CAUTION: When handling PFA, wear a lab coat and

gloves. Perform fixation steps under a chemical hood,

and dispose of PFA waste appropriately.

2. Wash the slices twice with 300 µL PBS for 5 min. Transfer

the slices to a 24-well plate.
 

NOTE: The experiment can be paused at this stage. Add

PBS-NaN3 to the slices and store at 4 °C. NaN3 is a toxic

compound; when handling solutions with it, wear a lab

coat and gloves. Steps 9.3-9.10 areto be performed in an

orbital shaker.

https://www.jove.com
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3. Quench the slices with 300 µL of 0.1 M glycine at 4 °C

overnight.

4. Wash out glycine with PBS at RT 3x for 10 min.

5. Permeabilise the slices with 300 µL of PBS-T at RT for

2 h.

6. Block using 10% goat serum in PBS-T at RT for 2 h.

7. Add 300 µL of primary antibody (anti-vimentin antibody

at a dilution of 1:200; see Table of Materials) diluted in

10% goat serum in PBS-T solution at 4 °C overnight.
 

NOTE: In steps 9.8-9.12, slices were light-protected to

prevent loss of fluorescence.

8. Wash primary antibody with PBS at RT 3x for 20 min.
 

NOTE: PBS was used instead of PBS-T to wash out

Triton X-100.

9. Add 300 µL of secondary antibody (either Alexa Fluor 488

or 647 at a dilution of 1:400; see Table of Materials) in

PBS at RT for 2 h.
 

NOTE: DAPI is added immediately after removing the

secondary antibody at a dilution of 1:10,000 for 5 min.

10. Wash the secondary antibody with PBS at RT 3x for 20

min. Wash with distilled water 2x for 1 min.

11. Transfer the slices to a glass slide using a fine brush, and

then dry at 30 °C for 20 min.

12. Mount the slices using an aqueous mounting medium.

Keep the slides at RT overnight for the mounting media

to curate.

10. Imaging acquisition

NOTE: Regardless of the DNA delivery approach (IUE or

EUE), slices were analyzed at the same developmental age

range (E17.5-E18.5). IUE allows neuronal progenitors to

divide and develop for two further days in vivo. EUE, on the

other hand, allows for the tracking of early developmental

events.

1. Switch on the chamber incubator and set it to 35 °C with

5% CO2-ideally 4 h before imaging-to allow microscope

components to equilibrate at 35 °C.

2. For deep imaging of slices, use water-immersion

objectives to reduce the mismatch in refractive index

between the tissue and objective.
 

NOTE: Here, super-resolution imaging mode was used.

Imaging through the PTFE membrane requires an

objective with a long working distance (~1 mm). If a

long working distance objective is unavailable, slices

may be transferred to an 8-well glass-bottomed dish. To

transfer slices, add 1 mL of slice media to the top of

the membrane, and then use a spatula to lift a slice and

transfer it to a well containing 200 µL of media. Remove

excess media using a 1 mL pipette tip leaving the slices

semi-dry.

3. For imaging axon growth, locate a region of the cortex

with low to medium cell density. For imaging growth

cone dynamics, locate a growth cone in the cortex's

intermediate zone or subventricular zone.

4. Define a z-stack size in the image processing software

(see Table of Materials). For axon growth in a large z-

stack, set a step size of 2 µm. For growth cones in a

smaller z-stack, set a step size of 1 µm.
 

NOTE: Always account for potential movement of the

growth cone and axon through the x, y, and z planes.

Axons grow at a much higher rate in organotypic cultures

than in in vitro cultures. Here, a z-stack of around 80 µm

to image axon growth was sufficient. For growth cone

dynamics, a z-stack of ~6 µm was adequate.

https://www.jove.com
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5. For imaging axon growth of neurons in a larger area,

define a tile scan.

6. Use the lowest laser power possible to minimize the

chances of bleaching growth cones during acquisition.

7. For imaging axon growth, acquire time-lapses for 2 h with

an interval of 5 min. For imaging growth cone dynamics,

acquire time-lapses for 2-5 min with an interval of 2.5-3 s.

11. Data analysis

1. Measure the speed of axon growth using kymographs

1. Open the image file in Fiji14  through File > Open

and select the image.

2. Obtain the maximum intensity projection of the time-

lapse through Image > Stacks > Z-Projection >

Maximum Intensity Projection.

3. Go through the time-lapse and locate a growing

axon.

4. Once located, draw a line through the growing axon.

Start from the tip of the axon in the first frame, and

follow the axon through the entire time-lapse.

5. Generate a kymograph using the plugin

KymoResliceWide.

6. Set the scale of the kymograph by going to Image

> Properties. Set the distance in µm in Pixel Width

and set the time in s or min in Pixel Height.

7. Go to Analyze > Measure.
 

NOTE: An angle relative to the x-axis will be given.

8. Calculate the speed of axon growth by

substituting the angle in the following

equation: SIN(RADIANS(θ))/COS(RADIANS(θ)) in

a spreadsheet.

2. Measure the volume of the growth cone using an image

analysis software (see Table of Materials).

1. Open the image file in the image analysis software

through File > Open and select the file of interest.

2. Select the Add New Surfaces wizard.
 

NOTE: A section on the lower-left corner will appear

with six steps for manual editing.

3. In step 1 -under Algorithm Settings- select

Segment Only A Region Of Interest. In step 2, crop

the frame to fit the entire growth cone in all frames.

4. Keep thresholding to Absolute Intensity in step

3, and ensure the entire growth cone region is

thresholded in step 4.

5. In step 5, select Number of Voxels lmg = 1 under

Filter Type.
 

NOTE: In the last step, multiple measurement sets

may be created. Here, only one measurement was

created for volume.

6. Select the Execute button to perform all the creation

steps and terminate the Add New Surfaces Wizard.

7. In the Statistics tab at the top of the wizard window,

select Specific Values and Volume under the

Detailed tab.

Representative Results

Representative results obtained with the described method

workflow are shown. E15.5 mice were used in the present

demonstration, though this protocol is easily adaptable to

virtually all embryonic ages ranging from E11 to late E17.

In this protocol, either ex utero electroporation (EUE; Figure

2A, 2C-I) or in utero electroporation (IUE; Figure 2B,C,

and 2J-Q) were used to deliver plasmids into the progenitor

https://www.jove.com
https://www.jove.com/
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neurons lining the lateral ventricles. These progenitors are

the source of future cortical projecting neurons (CPN)15,16 .

Plasmid mixes were prepared to drive sparse neuron-specific

expression of either membrane-targeted (Lyn)-mNeonGreen

(Figure 1A) or LifeAct-enhanced (E)GFP (Figure 1B) to

evaluate the overall behavior and actin dynamics in growth

cones, respectively. Furthermore, a plasmid mix aimed to

label individual neurons with either turbo(t)-RFP or zoanthus

sp. (Zs) green fluorescent protein (ZsGreen) (Figure 1C)

was included. This facilitates the monitoring of growth cone

behavior from independent neighboring neurons.

Brain dissection from electroporated embryos is a crucial

step that needs to be carefully performed to obtain high-

quality slices, preserving the native brain structure. Dissection

instruments and vibratome were prepared beforehand and

carefully ethanol-sterilized (Figure 3A,B). Next, the heads

of electroporated embryos were carefully dissected and the

brains were extracted. Here, representative dissection of

brains from the embryos subjected to EUE at E15 (Figure

3C-F) and E12.5 (Figure 3G-J) are shown. Brains are

immediately encased in an agarose matrix, sliced, and placed

on PTFE membrane inserts within a bottom-glass dish for

incubation (Figure 3K-M).

The health status of brain slices is a significant point for

control to ensure reliable results. A visual inspection for

any contamination was performed daily. Additionally, once

the culture was finalized, the brain slices are fixed and

subjected to immunohistochemistry. Here,4′,6-diamidino-2-

phenylindole (DAPI) was used to control the overall cellular

organization and vimentin staining to reveal glial organization;

particularly, radial glia (RG) scaffold. Typically, successfully

cultured brain slices derived from either IUE or EUE show

normal cellular distribution as revealed by DAPI and a

somewhat organized array of RG with apically oriented

pial-contacting processes17  (Figure 4A,B respectively).

Occasionally, marked disturbances in the RG scaffolding in

cultured brain slices are observed, especially in those derived

from EUE electroporation (Figure 4C). Brain slices with

extremely disorganized RG scaffold show impaired neuronal

migration and defective axon growth (not shown). Hence,

controlling the RG scaffold is an easy post-culture method to

sort the data obtained from reliable brain slices.

Brain slices derived from either IUE or EUE with Lyn-

mNeonGreen-expressing plasmid mix result in similar

sparse neuron labeling. A representative pyramidal CPN

expressing Lyn-mNeonGreen and the dynamic behavior of

its growth cone is shown as an example (Figure 5A and

Supplementary Video 1, top left). In addition, neurons were

labeled using a plasmid expressing an actin probe to analyze

actin dynamics of axonal growth cones in situ (Figure 5B and

Supplementary Video 1, bottom left). In situ experiments

were also performed with a dual-Cre/Dre fluorophore-

expressing plasmid design (Figure 1C and Supplementary

Video 1, right). tRFP or ZsGreen fluorophores in this

plasmid could be specifically and individually activated by

either Dre or Cre recombinases, respectively, in neighboring

neurons (Figure 5C). This experimental line-up allows side-

by-side analysis of growth cones from control neurons with

neighboring modified neurons (any given loss or gain of

function). This circumvents variability arising from the use of

different slices to test control and experimental conditions.

Kymographs generated from the recorded movie were

analyzed, from which dynamic growth parameters such as

protrusive activity over time and growth length can be easily

obtained (Figure 6A). Note that a simple adjustment in the

temporal resolution of the time-lapse allows measurement

https://www.jove.com
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of axon elongation speed for 2 h (Figure 6A). Furthermore,

the variation of growth cone volume over time-a measure of

general growth cone dynamic activity-can be easily obtained,

in this case with licensed software (Figure 6B and Figure

6E,F). This can be used to evaluate the speed of actin

treadmilling and the balance of filopodia/lamellipodia during

growth cone exploring activity.

 

Figure 1: Schemes of the plasmids used in the protocol. (A) pCAG-lox-STOP-lox-Lyn-mNeonGreen. (B) p-Tub-alpha-1-

LifeAct-GFP. (C) pCAG-lox-rox-STOP-rox-tRFP-pA-lox-ZsGreen-pA. Relevant information regarding plasmid components

and fluorophore's origin is found in the boxes. Please click here to view a larger version of this figure.

https://www.jove.com
https://www.jove.com/
https://www.jove.com/files/ftp_upload/63068/63068fig01large.jpg
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Figure 2: Workflow of ex utero and in utero electroporation of E15.5 mice. (A) Set up of surgery station for ex utero

electroporation. (B) Set up of surgery station for in utero electroporation. (C) Uterine horns pulled outside the abdominal

cavity of the anesthetized mouse. (D) Extraction of an embryo from the uterine sack. (E) Embryo sacrifice by complete

spinal cord transection via a diagonal incision; note that beheading was avoided. (F) Placement of embryo in the holder

and injected with DNA/Fast Green mixture into the left lateral ventricle. (G,H) Position the embryo's head between platinum

tweezer electrodes with the cathode (red arrow) over the cortex at a 60° angle. (I) Placement of embryo's arms (black

arrows) outside the holder to prevent sliding of the embryo during the procedure. (J) Rotation of the embryo inside the

uterine sack to expose the head. (K,L) Injection of DNA/Fast Green mixture into embryo's lateral ventricles through the

uterine wall. (M) Position the embryo's head between platinum tweezer electrodes with a cathode (red arrow) over the cortex

at a 60° angle. (N) Sutured muscle incision via running locking suture. (O) Sutured skin incision via an interrupted suture.

(P) Securing of the wound using surgical wound clips and disinfection using betadine. (Q) Placement of the mouse in the

recovery cage with far infrared warming light. Please click here to view a larger version of this figure.

https://www.jove.com
https://www.jove.com/
https://www.jove.com/files/ftp_upload/63068/63068fig02large.jpg
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Figure 3: Extraction of E15.5 and E12.5 brains and organotypic slice culture procedure. (A) Tools used for the brain

extraction procedure. (B) Set up of organotypic culture station. (C-F) Extraction of E15.5 brain. (G-J) Extraction of E12.5

brain. Dotted lines highlight the location of incisions. Red arrows are pointing out the direction of pulling by forceps. (K)

Embedding the brain in a 3 cm dish containing 3% low melt agarose, leaving a 1-2 mm agarose spacing gap under the brain.

(L) Collection of 150 µm brain slice. (M) Placement of brain slices on PTFE membrane inserts immobilized in a 35 mm dish

using paraffin film (blue arrow). Red star marking indicates a given brain slice collection from vibratome (L) and its transfer to

PTFE membrane (M). Please click here to view a larger version of this figure.

https://www.jove.com
https://www.jove.com/
https://www.jove.com/files/ftp_upload/63068/63068fig03large.jpg
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Figure 4: Conserved radial glial cell structure in healthy organotypic slices. Confocal images of E17.5 brain slices

revealing RG array (vimentin; green) and overall cell organization (DAPI; magenta) following IUE (A) and EUE (B,C). Note

the strong disturbances in the RG array that may occasionally result from EUE (C). Magnifications correspond to the red

dotted frames in the main figure: scale bars, 10 µm. Please click here to view a larger version of this figure.

https://www.jove.com
https://www.jove.com/
https://www.jove.com/files/ftp_upload/63068/63068fig04large.jpg
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Figure 5: In situ visualization of the growth cone dynamics in acute organotypic slices. (A,B) Neurons and their

corresponding growth cones labeled with Lyn-mNeonGreen and LifeAct-GFP, respectively. Red star marking growth cone of

Lyn-mNeonGreen expressing neuron. Blue asterisk marking growth cone of LifeAct-GFP expressing neuron. (C) Neighboring

neurons labeled with the dual plasmid system containing tRFP (magenta) and ZsGreen (green) and their corresponding

growth cones. Growth cones imaged (right) were outside the captured frame (left), obtained shortly after acquiring the growth

cone time-lapse; scale bars, 5 µm. Please click here to view a larger version of this figure.

https://www.jove.com
https://www.jove.com/
https://www.jove.com/files/ftp_upload/63068/63068fig05large.jpg
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Figure 6: Analysis of axon growth speed and growth cone volume. (A) Axon tracing on a neuron expressing Lyn-

mNeonGreen (top) and its corresponding kymograph (below) generated using ImageJ. (B) Reconstruction of z-stack video of

growth cone using the image analysis software (top) and the same growth cone highlighted using the surfaces measurement

tool (below). (C) Graphs showing changes in growth speed over time for several axons. (D) The average growth speed of

axons is quantified in (C). (E) Graph showing the changes in the growth cone volume over time. (F) The average volume of

growth cones is quantified in (E); scale bar, 5 µm. Please click here to view a larger version of this figure.

https://www.jove.com
https://www.jove.com/
https://www.jove.com/files/ftp_upload/63068/63068fig6v2large.jpg
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Figure 7: Radial migration and neuronal polarization of pyramidal cortical neurons. Diagram illustrating developing

pyramidal cortical neurons (pink) migrating radially from the germinal ventricular zone (VZ) toward the pia surface. Guided

by radial glia processes (gray), migrating polarized neurons establish a leading process, future dendrite, and trailing process,

future axon, that continue to extend downward toward the intermediate zone (IZ). Dashed red boxes represent the cortical

areas where growth cones were imaged. Specifically in the IZ, subventricular zone (SVZ), or joining axon bundles (green).

The illustration was created with a web-based tool, BioRender.com. Please click here to view a larger version of this figure.

https://www.jove.com
https://www.jove.com/
https://www.jove.com/files/ftp_upload/63068/63068fig07large.jpg
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Plasmid Concentration (µg/µL) Intended use

pCAG-lox-STOP-lox-Lyn-mNeonGreen 0.25

+ +

p-Tub-alpha-1-iCre 0.08

Labelling of membrane

targeted protein (Lyn)

p-Tub-alpha-1-LifeAct-GFP 0.125 Filamentous actin (F-actin)

labelling in growth cones

pCAG-lox-rox-STOP-rox-

tRFP-lox-Lyn-ZsGreen

1

+ +

p-Tub-alpha-1-iCre 0.004

+ +

p-Tub-alpha-1-Dre 0.2

Independent labelling of two

populations of neighboring neurons

Table 1: List of plasmids used in the Protocol. Name, concentration, and intended use of each utilized plasmid.

Supplementary Video 1: In situ visualization of the growth

cone dynamics in acute organotypic slices. Dynamics

of growth cones labeled with Lyn-mNeonGreen (top left)

and LifeAct-GFP (bottom left). Neighboring growth cones are

differentially labeled with the dual plasmid system containing

tRFP (magenta; top right) and ZsGreen (green; bottom right).

Imaging interval, 2.5 s. Scale bars, 5 µm. Please click here

to download this File.

Discussion

How the growth cones sense and react to their surrounding

environment to coordinate simultaneous axon extension and

guidance is still a matter of debate3,18 . Pioneering studies

in 2D substrates provided a glimpse into the fundamental

molecular mechanisms generating the forces that drive

growth cone dynamics during axon formation, outgrowth,

and navigation2,10 ,11 ,12 ,19 . More recently, studies in 3D

matrices revealed how much influence a third dimension

has in the behavior of the growth cone and consequently

in axon growth8,9 . Nevertheless, the intricate mechanisms

instructing growth cone dynamics in vivo remain to be

thoroughly examined.

Preparation of organotypic slice cultures from IUE or EUE

brains is widely utilized and well-documented. It has become

a golden standard allowing scientists to gain insights into

the development and behavior of neurons in the living brain

tissue20,21 . Indeed, this technique has been successfully

utilized in combination with various high-resolution imaging

techniques to visualize specific molecular processes and

morphological events in situ. Such studies include, but are

not limited to axon formation and extension19,22 , cortical

neuronal migration19,22 ,23 ,24 , centrosome dynamics25,26 ,

https://www.jove.com
https://www.jove.com/
https://www.jove.com/files/ftp_upload/63068/Supplementary_Video_1.mp4
https://www.jove.com/files/ftp_upload/63068/Supplementary_Video_1.mp4
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microtubule dynamics27 , as well as the functional dynamics

of pre-and postsynaptic compartments28,29 .

This protocol addresses a gap in experimental neurobiology,

visualizing the growth cone dynamics of developing cortical

neurons in situ, in ex vivo acute brain slice cultures, and the

tools to analyze the data obtained.

Acute brain slice cultures were utilized to establish this

protocol because they (1) with some practice, are easy to

generate; (2) present an accessible system to study growth

cones embedded in a quasi-fully-physiological environment,

yet transparent enough to allow high-resolution live-cell

imaging; (3) can be expanded for its use with a myriad

of transgenic mouse lines; (4) combined with either IUE or

EUE, provide virtually unlimited potential to deliver molecular

tools to evaluate the performance of growth cones and

axons in vivo under loss/gain of function regimes, along with

fluorescent reporters and cytoskeleton probes.

This methodology was described in the context of both

EUE and IUE. Although still a highly reliable method, EUE

resulted in an increased incidence of brain slices showing

a disorganized RG network compared to those obtained

with IUE as a delivery method (Figure 4C). Disturbances

in the RG array strongly affect neuronal migration and the

pattern of axon elongation30,31 . These are key parameters

that predict where to find axons for analysis at a given

time and the type of environment they are navigating. Brain

slices with a significantly disrupted RG network typically

have impaired cortical neuron stratification. This, in turn,

produces axons with chaotic trajectories. Therefore, it is

strongly recommended to control for the structural integrity

of the RG network. Interestingly, poor structural integrity

correlates with increased age of the embryonic brain. Indeed,

such effects in younger E12.5-E13.5 embryos were typically

not observed19 .

The present protocol is thorough and straightforward.

Nevertheless, there are a few critical steps where special care

and attention must be taken to obtain optimal results. These

have been expressly noted in the protocol and include (1)

tuning the amount of DNA used in the electroporation to get

sparse labeling; (2) avoiding damage during the extraction

of brains; (3) controlling the temperature of the agarose

during brain casing; (4) troubleshooting the ideal percentage

of agarose for brains of a given age; and (5) selection of

fluorophores, the experience of which follows. During protocol

optimization, the performance of several fluorophores in live-

cell in situ imaging was tested. Monomeric GFP variants

EGFP and NeonGreen for the preparation of the LifeAct-

and Lyn-tagged plasmids were chosen for this protocol

(Figure 5A,B). Additionally, the RFP variant mScarlet was

tested and found highly suitable for this set-up (data not

shown). Multimeric tRFP (dimer) and ZsGreen (tetramer)

(Figure 5C and Supplementary Video 1, right) were

also tested. These fast-folding super-bright fluorophores are

recommended when the method requires rapid fluorescent

signal generation after DNA delivery.

A common practice in using slice cultures is to utilize

slices from different brains to test control and experimental

conditions. This represents an inherent source of unwanted

variability. Here, an expression system that enables

independent modification of neighboring neurons and

reporters' expression for identification was used. Note that

in this demonstration (Figure 5C), there were no differences

between neurons expressing either of the fluorophores.

However, as an example, such a plasmid mix combined with

a transgenic mouse line harboring a Cre-sensitive gene will

https://www.jove.com
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label with tRFP (Dre-sensitive) neurons that remained as

wild type. In contrast, the ZsGreen (also Cre-sensitive) will

label the recombined neurons. Hence, growth cones of the

two different genotypes, and likely also phenotypes, could be

studied side-by-side simultaneously in the same brain slice.

Localization of axons and growth cones for analysis is

an important consideration. Cortical neurons polarize while

radially migrating from the ventricular zone (VZ) toward the

cortical plate (CP). During this process, neurons form a

leading process (a future dendrite) and a trailing process that

will become the axon, eventually joining pioneering axons

in the intermediate zone (IZ), establishing axon tracts32 .

Therefore, to capture axonal growth cones, imaging was done

on axonal fibers in the IZ, including axons exiting the CP

and early-generated axons already associated with axonal

bundles; or eventually, in fibers that transverse the IZ and

extend below it (Figure 7).

This protocol makes it feasible to perform super-resolution

imaging of neurons within organotypic slices. Historically, light

scattering was a significant problem faced when imaging thick

specimens. Over the last two decades, extensive advances

in optical technologies made imaging of thick specimens

possible. Here, a long working distance objective was used

to visualize smaller structures better, such as growth cones.

Unavoidably, this protocol does not capture more detailed

events such as retrograde actin flow or microtubule dynamics.

The long-working distance objective, which necessitates a

lower Numerical Aperture (NA), preserves information from

thick slices. However, it was also possible to adapt this

protocol to use with objectives of shorter working distance.

This required a smooth transfer of slices to a glass-bottomed

dish to preserve structural integrity. However, using this

method resulted in shorter survival-~15 h-due to loss of gas

exchange (data not shown). Unlike 2D cultures, growth cones

in 3D occupy a larger volume and require movement-artifact

compensation in the z-axis. To increase the ability to image

detailed events, modern confocal technology must be utilized.

Therefore, it is recommended to use a fast-scanning z-stack

motor, such as the z-Galvo available on highly sensitive

confocal microscopes33 .

Of note, this protocol presents three main limitations. First, it

is often challenging to control levels of expression/number of

expressing cells of any given plasmid in vivo. This introduces

variability between all slices even when maintaining the

same plasmid concentration. Therefore, the selection of

the regulatory elements in the expression vectors used

must be predetermined with care. Second, imaging detailed

events using membrane inserts is currently not feasible. This

second limitation may be overcome with the methodological

updates proposed in the previous paragraph. Lastly, growth

cones are highly photosensitive and can quickly become

photobleached. Therefore, frequent imaging of the growth

cones, for as little as 5 min using laser scanning microscopes

can often collapse the growth cones. In this regard, new

advancement in light-sheet microscopy generated devices

can be adapted for long-term imaging of the brain slices34 .

Protocols of this like are envisioned to open new research

avenues, allowing a better understanding of what it takes for

a growth cone to read and react toward a complex in vivo

environment, and more importantly, to unravel the mechanics

of this sophisticated interplay.
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